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SMART Board Software for Macintosh
Computers FAQ
NOTE: The following FAQs relate to the latest SMART Board software release and apply
only to Macintosh computers. The latest version of SMART Board software for Macintosh
computers includes SMART Board driver 6.0.2 and SMART Notebook 1.3.2. software.

Which versions of the Mac OS operating system can run the latest
version of SMART Board software (SMART Board driver 6.0.2 and
SMART Notebook 1.3.2)?
SMART Board driver 6.0.2 and SMART Notebook 1.3.2 software can be installed and run on
Mac OS 8.5 through Mac OS 10.1.5 operating system software.

However, since Apple Computer Inc. no longer supports Mac OS 10.0.x through 10.1.4, we
can't guarantee that this newly released version of SMART Board software will run correctly
on these operating systems. If you're running Mac OS 10.1.1 through 10.1.4, Apple offers
free upgrades to 10.1.5, so we suggest you visit the Apple Web site for this free upgrade.

Does SMART Board software work with QuickTime Player?
Yes. SMART Board software for Mac OS X works with QuickTime 6.0 to provide a simple,
inexpensive way to write over game footage, educational films, satellite images, digital video
and storyboards. Also, annotations made over video played on QuickTime 6.0 on a SMART
Board interactive whiteboard can be readily captured into SMART Notebook software (using
the Screen Capture tool).

Can I use Notebook files I've created on a Windows operating system
on a computer running Mac OS X operating system?
File interchange exists between Notebook software for Mac OS X and Notebook software for
your PC. This means that you can create a Notebook file on your PC and save it as a Mac
OS X Notebook file. Also, files created in Mac OS X Notebook software can be opened in
Notebook software on your PC. This is applicable to Notebook version 2.4 software or better
and SMART Board 7.1 software or better.

Does SMART Board software function the same on Mac OS 8.5 −−−− 9.x
operating systems as on a Mac OS X operating system?
There are a few slight differences in the way SMART Board software works, but these will be
eliminated with the next release of SMART Board software.

With the current version of SMART Notebook software, users with the Mac OS X operating
system will not be able to:

• group or ungroup objects with (users of the Mac OS 8.5 − 9.x operating systems do
have access to the Group and Ungroup commands in the Draw menu)

• use the "circle and tap" erasing method

• rearrange stacked objects with the Bring to Front and Send to Back commands in
the Draw menu (Mac OS 8.5 −−−− 9.x operating systems only)

• use the Page Setup command available in the File menu of Notebook software for
Mac OS 8.5 −−−− 9.x operating systems (allowing you to specify how the individual
Notebook pages will appear on the printout)
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• use multiple SMART Board interactive whiteboards

• use PowerPoint software as a board-aware program

What are the most important differences between older Macintosh versions
of SMART Board software and the latest Macintosh release of SMART Board
software?
• SMART Board driver 6.0.1 fully supports USB. Use the SMART USB Adapter cable to

directly connect your USB Macintosh to the DB9 serial port on your SB500 Series
SMART Board interactive whiteboard. You must order the SMART USB Adapter cable
separately (part #USB-FRU).

With this latest software release, you can access tools that complement your interactive
whiteboard use. Click the SMART Board Tools icon in the menu bar (Mac OS 8.5 − 9.x) or
the Dock (Mac OS X) for access to the following tools.

TOOL FUNCTION

Orient To perform quick orientation

Control Panel To view board status, configure the Pen Tray tools, and see
Aware settings

Floating Tools To use virtual pens and drawing tools

SMART Keyboard To access a virtual keyboard for use at the board

SMART Notebook To create and save the notes you write on the board

Capture Selection
Capture Screen

Screen Capture (Mac
OS X)

To capture an image of annotations and the background
application right into SMART Notebook software

Restore Annotations To quickly return your most recently deleted annotations to
the board

Can I run SMART Board software on a Macintosh computer with a 68K
Operating System?
No. SMART Board software for Macintosh computers requires a Power PC using OS 8.5 to
OS X. If you have a 68K operating system, you can’t use version 6.0 or version 6.0.2; use
version 5.2 of the SMART Board Software instead.

How do I open and manage the SMART Board Tools?
Every time you start your computer, the SMART Board tools icon is in your menu bar (Mac
OS 8.5 − 9.x) or the Mac OS X Dock. Just click the icon to see a menu of options.

SMART Board tools and SMART Notebook software have extensive Help files associated
with them. You can also access specific Help topics by using the context-sensitive button.
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How do I check on my port connections or add a serial port?
You can use the SMART Board Control Panel, which displays important information about
your SMART Board. Click the SMART Board Tools icon and then select Control Panel.
The SMART Board Control Panel dialog box opens with the Boards tab displayed. You'll see
a listing of your SMART Board interactive whiteboards along with a status icon:

 indicates a properly functioning projected board
 indicates a properly functioning non-projected board
 indicates a non-functioning board

Use the Control Panel (Boards tab) to change the mode of your interactive whiteboard
(either Projected or Non-Projected), add an interactive whiteboard on another port, or view
status information for your connected board.

Use the Control Panel (Pen Tray tab) to change the color of your Pen Tray styluses, the size
of your eraser or the functionality of the Pen Tray buttons.

Use the Aware tab to set or change your preferences for Microsoft PowerPoint software for
Macintosh computers.

Can I change the color of the electronic ink created by my Pen Tray stylus?
You can change the color of the electronic ink, the ink’s width (in pixels) and you can make
the ink transparent so that the pen acts like a highlighter. Click the SMART Board tools icon
and then select Control Panel. Switch to the Pen Tray tab and then click the stylus you
want to alter.

Can I make the eraser a different size?
You can change the width of the eraser to suit your needs. Click the SMART Board tools
icon and then select Control Panel. Switch to the Pen Tray tab, click the eraser button and
then select an appropriate width in pixels.

Sometimes I want to print a SMART Notebook page without leaving the
interactive whiteboard. Is there an easy way to do this?
Yes. Simply reconfigure one of the Pen Tray buttons to print with a press of a button. You
can alter the functionality of either button to:

• print a Notebook page
• go to the next Notebook page
• go to the previous Notebook page
• clear the screen of annotations
• produce a floating mouse
• launch the on-screen keyboard

Click the SMART Board tools icon and then select Control Panel. Switch to the Pen Tray

tab, click  and then alter the behavior of your buttons in either projected or non-
projected mode.

What is Aware and how do I access Aware preferences?
Aware is a program component of SMART Board software for Macintosh computers (Mac
OS 8.5 − 9.x only) that integrates your interactive whiteboard with Microsoft PowerPoint for
Macintosh computers. With PowerPoint software in Slide Show mode, you can:

• use your finger to advance your presentation
• access Internet links on your slides with a simple touch
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• make annotations over the slide, which can then be captured into or printed with
Notebook along with an image of the slide

Click the SMART Board tools icon and then select Control Panel. On the SMART Board
Control Panel dialog box, click the Aware tab. Now you can change your touch preferences
for PowerPoint software.

How do I capture my annotations?
For Mac OS 8.5 − 9.x users, click the SMART Board tools icon in the menu bar and select
either Capture Selection or Capture Screen. For Mac OS X users, select Screen Capture
> Capture Selected Area or Screen Capture > Capture Full Screen. SMART Notebook
software will be automatically launched to accept your image.

Cleaning Your SMART Board Interactive Whiteboard
If my SMART Board interactive whiteboard is always touch-sensitive, how
can I clean it without affecting the current projected application?
Since any touch on your board will activate program components or scramble desktop
icons, we recommend that you first log out. Put the projector into standby mode (the lamp is
turned off) to more easily view dirt and streaks.

To clean the writing surface of the board, use a standard glass cleaner. Just spray the
board with cleaning fluid and wipe with a paper towel.

Connecting Your SMART Board Interactive Whiteboard
Can I expect any differences when I connect the board to my computer?
SMART continues to supply the same 20' serial cable. The procedure for connecting this
cable and its keyboard power adapter has not changed. However, if you have a USB port,
you can now order a SMART USB Adapter cable from SMART (part #USB-FRU). The
SMART USB Adapter cable is a straightforward connection from the interactive whiteboard
DB9 serial connection to the USB port on your computer. Power for the board is drawn
directly from the USB port.

NOTE: The SMART USB Adapter cable is designed specifically for the SMART Board
interactive whiteboard. Do not use it to connect any other device.

Does the USB connection affect SMART Board software installation?
When you connect your board to the computer using the SMART USB Adapter cable, the
Ready Light on the Pen Tray will turn red and you can proceed to install software.

If you don’t see the Ready Light change to red, it’s possible that your USB Device Extension
is not active. To activate the USB Device Extension, click the Apple icon, point to Control
Panels and select Extensions Manager. Scroll through the list until you find USB Device
Extension. Click to remove the X in the On/Off box and then click Restart. You may have to
download the appropriate extension from Apple. When the extension is active and your
Ready Light is red, install the SMART Board Software for Macintosh computers.

Can I expect any differences when I install the new SMART Board software
on my serially connected Macintosh computer?
After installation, you have to manually configure the serial port.
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How do I manually configure the serial port?
Click the SMART Board tools icon and then select Control Panel. The SMART Board
Control Panel dialog box opens with the Boards tab displayed. Click the Select button under
Serial Ports. The Pick a Port dialog box opens for you to select a port to which your
SMART Board interactive whiteboard is connected and then click OK.

If you're unsure of the correct port, press the Auto Detect button in the Pick a Port dialog
box to initiate board detection. Your ports will be searched for the presence of an attached
board.

How could I extend the length of the SMART USB Adapter cable for my SB5
SMART Board interactive whiteboard?
If you need cabling of less than 50 feet, you can connect a "straight through" male/female
DB9-to-DB9 serial cable to the DB9 end of the SMART USB Adapter cable. Connect the
other end of the serial cable to the 9-pin serial port on the Pen Tray.

NOTE: This serial extension cable must be a minimum of 24 AWG.

If you need an overall length of cable exceeding 50 feet, you must connect a SMART
serial/power cable to the DB9 end of the SMART USB Adapter cable. You’ll need to use a
DB9 (male)-to-DB9 (male) gender adapter to enable this connection. You’ll also need to
connect an external 12V DC power supply to the power socket in the long DB9 end of the
serial/power cable to provide sufficient power for the Pen Tray.

While you may use any length you like, and connect several SMART serial/power cables to
meet your distance needs, the total overall length cannot exceed 100 feet.

Older SMART Board Models
I have an older SB2 SMART Board interactive whiteboard (the Pen Tray has a
gold box mounted underneath). Can I use the new software and/or the
optional SMART USB Adapter cable with my old board?
You can certainly use the new SMART Board software for Macintosh computers with older
boards and Pen Trays, which include model PT3, some PT5 Pen Trays (those equipped
with the bottom-mounted gold box), and the PT4 Pen Tray used in older Rear Projection
SMART Board interactive whiteboards (RPSB 585s and RPSB 420s).

The only difference you'll notice is that the Ready Light in your Pen Tray will flash
approximately every four seconds during use. Don't be alarmed by this flashing; it
represents normal behavior and shouldn't be mistaken for a malfunctioning Pen Tray.
However, you must continue using your original serial cable connection, as these Pen Trays
do not support the optional SMART USB Adapter cable.

I have an older SB3 SMART Board interactive whiteboard with a PT5 Pen
Tray (without a bottom-mounted gold box). I've upgraded my computer and
would like to use your USB Adapter cable to connect to my old board. Is this
possible?
Both SMART Board software for Macintosh computers and the SMART USB Adapter cable
are compatible with SB300 series boards that have a PT5 Pen Tray equipped with an SC5
controller (without a bottom-mounted gold box). However, you’ll need three additional
components: a MOD6-to-MOD6 cable, a MOD6-to-DB9 adapter, and a DB9 male-to-male
gender adapter.
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Disconnect the original cable (a mini-DIN8-to-RJ11 MOD6 cable) and discard it. Plug the
MOD6-to-MOD6 cable into the DB9 adapter, the DB9 adapter into the male-to-male gender
adapter, and finally the gender adapter to the DB9 end of the SMART USB Adapter cable.
Insert the USB end of the SMART USB Adapter cable into the USB port on your computer.

Unfortunately, any Pen Tray with an SC3 or earlier controller is not compatible with the
SMART USB adapter cable.

Pen Trays with SC3 controllers include:

• some PT5 and PT7 SB 200 or 300 series boards (check the log file in the SMART
Control Panel to determine the SC controller version number).

• PT4 and some PT8 Pen Trays (check the log file in the SMART Control Panel to
determine the SC controller version number).

NOTE: The SMART USB Adapter cable is designed specifically for the SMART Board
interactive whiteboard. Do not use it to connect any other device.
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